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Overview

Seminar Description

Advanced Land Valuation: Sound Solutions to Perplexing Problems focuses on unusual 
and complex land valuation assignments and uses a combination of lecture, discussion, 
question and answer, and sample case studies to lead participants to suggested 
solution strategies. The seminar was developed for residential and commercial real 
estate appraisers and consultants, real estate agents, landowners, land use planners, 
developers, and investors. Given the advanced nature of the topics to be covered, 
attendees are expected to have familiarity with discounted cash flow concepts and 
general valuation approaches, specifically yield capitalization.  

Land can be appraised using several methods, which include the sales comparison 
approach, allocation, extraction, land residual technique, ground rent capitalization, 
and subdivision development analysis. All six methods are described in The Appraisal 
of Real Estate, 15th edition, and covered in various Appraisal Institute courses. This 
seminar focuses on the last three methods and in some cases presents more advanced 
methodology than the courses. For the land residual technique, this seminar uses a 
dynamic methodology employing discounted cash flow analysis. The presentation of 
ground rent capitalization uses yield capitalization to discount multiple forms of ground 
rent consideration into value. Lastly, for subdivision development analysis, the seminar 
includes complex properties and the incorporation of market analysis conclusions in 
highest and best use analysis. (See the table on the next page, which is a summary of 
the applicability and limitations of land valuation methods.1)

The case study material will be demonstrated primarily in Excel, and a basic working 
knowledge of Excel is helpful but not required. Excel screenshots are provided in the 
handbook for attendees who are not familiar with Excel. Laptops are highly recommended 
but not required. The Excel models that are downloaded with the course materials can be 
used by participants in their day-to-day work. Class participation is strongly encouraged, 
since much can be learned from the collective experiences of the participants.

1. The Appraisal of Real Estate, 15th ed. Chicago: Appraisal Institute 2020, Page 340.
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The Appraisal of Real Estate340

 Table 19.1 Applicability and Limitations of Land Valuation Methods

Sales Comparison
Procedure Sales of similar, vacant parcels are analyzed, compared, and adjusted to provide a value indication for the 

land being appraised.
Applicability Sales comparison is the most common technique for valuing sites, and it is the preferred method when 

comparable sales are available.
Limitations A lack of sales and the comparability of the available data may weaken support for the value estimate.
Market Extraction
Procedure An estimate of the contributory value of improvements is deducted from the total sale price of a property to 

arrive at an indicated land value for the comparable. The indicated land values of the comparables are then 
compared to provide a value indication for the land being appraised.

Applicability This technique is most applicable when the contribution of the improvements to total property value is 
generally small and relatively easy to identify. (The technique is frequently used in rural areas.)

Limitations The appraiser must be able to determine the value contribution of the improvements.
Allocation
Procedure A ratio of site value to property value is extracted from comparable sales in competitive locations and applied 

to the value of the improved subject property or comparable properties to develop the site value.
Applicability This technique is applicable when

• Valuing one-unit residential lots where ample sales of improved properties are available and the ratio of 
site value to improved property value can be supported. This method tends to be less accurate for com-
mercial properties, especially when the number of vacant land sales is inadequate.

• For commercial properties or where relatively few sales are available, allocation can provide a test of 
reasonableness rather than a formal opinion of site value.

Limitations The allocation method does not produce conclusive value indications unless ample sales data is available. 
The method is rarely used as the primary land valuation technique for properties other than residential 
subdivision lots. Also, land-to-property value ratios can be difficult to support.

Land Residual Analysis
Procedure The net operating income attributable to the land is capitalized or the cost to construct an improvement is 

deducted from the value as if completed to produce an indication of the land’s contribution to the total property.
Applicability This technique is applicable in the financial analysis of alternative uses of a particular site in highest and 

best use analysis and when land sales are not available.
Limitations When used as an income capitalization technique, the following conditions must be met:

1. Building value is known or can be accurately estimated.
2. Net operating income to the property is known or can be estimated.
3. Both building and land capitalization rates are available from the market.
When using a cost-based technique, the appraiser must be able to determine the value contribution of the 
improvements, estimated at their depreciated cost

Ground Rent Capitalization
Procedure A market-derived capitalization rate is applied to the ground rent of the subject property.
Applicability This method is useful when comparable rents, rates, and factors can be developed from an analysis of sales 

of leased land or sales of unleased land for which the market rent can be credibly determined.
Limitations An adjustment to the value indication for property rights may be necessary.
Subdivision Development Analysis (Discounted Cash Flow Analysis)
Procedure Direct and indirect costs and entrepreneurial incentive are deducted from an estimate of the anticipated 

gross sales price of the finished lots or units, and the net sales proceeds are discounted to present value 
at a market-derived rate over the development and absorption period. If entrepreneurial incentive is not 
deducted as a line-item expense, then the discount rate must reflect the full effect of any profit.

Applicability This technique is applicable when subdivision development is the highest and best use of the land and there 
is market support for immediate absorption.

Limitations Discounted cash flow analysis requires significant amounts of data such as development costs, profit margins, sales 
projections, and the pricing of developed lots or units, together with a supportable forecast of market absorption.

Note: Certain US states do not recognize subdivision development analysis as an acceptable valuation method for purposes of litigation valuation.
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Learning Objectives

At the conclusion of the seminar, participants should be able to

 � Utilize a land residual technique based on DCF analysis, the latter of which also 
incorporates the conclusions of a market analysis, to value land intended for two 
alternative, competing uses – for-rental apartments versus for-sale condominiums

 � Determine the highest and best use of land when the legally permissible, 
physically possible, and financially feasible use(s) are very uncertain and cannot 
be determined using traditional methodologies

 � Determine land value when its value is a function of a curvilinear relationship with its 
appropriate unit of comparison – in this case, determining the value of land suitable 
for apartment development as a function of density (allowable units per acre)

 � Determine land rent using a nontraditional unit of comparison – in this case, land 
rental value based on average traffic volume

 � Estimate the value of land subject to a long-term ground lease with multiple forms 
of financial benefits accruing to the landowner

Learning Enhancements

The seminar has been designed with a variety of elements to enhance your learning 
experience.

 � Preview. To give you a taste of what is to come, you will find a Preview page, which 
begins each Part. Included on the Preview page is a brief overview of the content, 
learning objectives to consider as you move through the content, and learning tips 
that will assist you in understanding the information you’re about to learn in the class.

 � Learning Objectives. Each learning objective covers essential information you need 
to know to fully understand the concepts in the seminar. Look them over before 
each Part begins so that you have a frame of reference as you move through the 
material. At the end of each Part, reread the objectives. Are you able to perform 
what is stated? If not, this is the time to ask your instructor for help. Or, review the 
concepts that you do not understand.

 � Examples, Problems, and Discussion Questions. Supplementing the discussions, 
we’ve included examples, problems, and discussion questions to help you visualize 
and practice what you are learning.

 � Case Studies. The case studies in the seminar contain exercises and problems that 
allow practical application of the methods used to appraise unusual and complex 
land valuation assignments.
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 � Review. Each Part concludes with a review. Included in the review are the learning 
objectives and key terms and concepts that have been covered. Also, we’ve 
included recommended readings from textbooks, which will reinforce what you have 
learned in class.

 � Suggested Solutions. A tabbed section of Suggested Solutions appears at the end 
of the Seminar Handbook. This component contains solutions to the discussion 
questions, problems, and case studies.

Classroom Guidelines

To make the learning environment a positive experience for everyone attending, please 
follow these guidelines when class is in session.

 � 100% attendance is required. No exceptions.

 � Limit use of laptops and wireless devices to classroom projects.

 � Communicate with business associates during break time instead of class time.

 � Put away reading materials such as newspapers and books that are not used in class.

 � Please silence cell phones.

 � Please do not record the lectures. Recordings are not permitted.

 � Refrain from ongoing conversations with those seated near you and other 
distracting behavior.

General Information

 � Laptop. A laptop is recommended but not required, and a basic working 
knowledge of Excel is helpful but not required. Excel screenshots for the Excel 
worksheets are provided throughout the handbook, and participants can use 
those to participate in the case study. Following registration, participants can 
log into their accounts and download the four Excel files used with Case Studies 
1, 3, 4, and 5. These worksheets could be useful models in day-to-day appraisal 
practice. If bringing a laptop, participants will need to install the Excel Analysis 
ToolPak add-in in prior to class. 

 � Breaks. There will be two 10-minute breaks during the morning session and two 
10-minute breaks during the afternoon session unless noted otherwise by the 
program sponsor. The lunch break is one hour.

 � Attendance sheets will be distributed during class to verify your attendance during 
the morning and afternoon sessions.

 � Certificates of completion may be downloaded upon completion of the seminar. 

 � Attendance for the entire seminar is required.



Appraisal Institute Advanced Land Valuation: Sound Solutions to Perplexing Problems ix

Excel and Analysis ToolPak

If you plan on bringing a laptop to class, you must have installed Excel 2010 or a 
later version. These directions apply to Excel 2010, 2013, and 2016. The Analysis 
ToolPak should have installed with Excel, but some steps may be necessary to make it 
operational. If the Analysis ToolPak is operational, you will see a Data Analysis choice 
displayed in the Analysis group on the Data tab at the far right of the menu ribbon at 
the top of the worksheet. Click on Data Analysis, and a small Data Analysis window will 
open in front of the worksheet. If you are able to open the Data Analysis window, then the 
Analysis ToolPak is operational, and you can skip the directions below. 

Installing the Analysis ToolPak: Using the computer that you intend to bring to class, 
open Excel and click on the File tab. Click the Options link on the left-hand menu bar. 
Then click the Add-Ins category. In the Manage box, select Excel Add-ins, and then click 
Go. If you are using Excel for Mac, in the file menu go to Tools > Excel Add-ins. 

In the Add-Ins box, check the Analysis ToolPak checkbox, and then click OK. 

If Analysis ToolPak is not listed in the Add-Ins available box, click Browse to locate it. If 
you are prompted that the Analysis ToolPak is not currently installed on your computer, 
click Yes to install it. 

Note to Mac users: Microsoft does not support the Analysis ToolPak in Mac Office Excel 
2008 or Mac Office Excel 2011. However, they do suggest free third-party add-ins with 
similar functionality. For more information, see 

2008: http://answers.microsoft.com/en-us/mac/forum/macoffice2008-macexcel/what-
happened-to-the-data-analysis-toolpak-or/7a9e9491-cb73-4496-ac06-3ada487c719a

2011: http://answers.microsoft.com/en-us/mac/forum/macoffice2011-macexcel/what-
happened-to-the-data-analysis-toolpak-or/740ff33a-6ed9-4553-bc09-5cef06ce5f23

Recommended Textbooks

 � Stephen F. Fanning, Market Analysis for Real Estate, 2nd ed., Chicago: Appraisal 
Institute, 2014.

 � The Appraisal of Real Estate, 15th ed. Chicago: Appraisal Institute, 2020.

 � The Dictionary of Real Estate Appraisal, Chicago: Appraisal Institute, 2015. 

Prerequisites

 � None.




